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How to check a file
Spelling Sentry can check the spelling of ASCII text files and Microsoft Write files.
You can check files using two methods: by invoking a menu command, or by dragging a file from the File
Manager.

To check a file using the menu:
1. From the Check menu, select File.
2. Spelling Sentry displays an Open File dialog. Locate and select the file you wish to check, then select 

the OK button.
3. Spelling Sentry checks the words in the file.
4. Spelling Sentry pauses when it detects a misspelled word so you can correct it.
5. When checking is complete, Spelling Sentry saves any replacements made to disk. It also displays 

some statistics.

To check a file from the File Manager:
1. Locate the file you wish to check in File Manager's window.
2. Drag the file from File Manager's window onto Spelling Sentry's window or icon ("drag" means click 

and hold the left mouse button, move the mouse, then release the button). Note: You can drag a file 
to Spelling Sentry's icon only if Spelling Sentry is "minimized" at the bottom of the screen.

3. Spelling Sentry checks the words in the file.
4. Spelling Sentry pauses when it detects a misspelled word so you can correct it.
5. When checking is complete, Spelling Sentry saves any replacements made to disk. It also displays 

some statistics.

Notes:

You can cancel a spell-checking session by selecting the Stop Checking button.
Spelling Sentry can check files produced by the Windows Write program and ASCII text files. If the file 
you select doesn't appear to be of either type, Spelling Sentry will display a warning message asking if 
you want to check the file anyway. Spelling Sentry will attempt to identify words in the file, but bear in 
mind that it may become confused by formatting codes, etc. Replacing misspelled words in these 
files is not recommended.

See also
How to check the clipboard
How to set preferences
How to respond to spelling errors
Statistics



How to check the clipboard
You can check the spelling of words in the Windows clipboard.
1. In another application, select the text you want to check, then copy it to the clipboard. You can do this 

in most applications by selecting the Copy item from the Edit menu.
2. In Spelling Sentry, select the Clipboard item from the Check menu.
3. Spelling Sentry checks the words in the clipboard.
4. When Spelling Sentry detects a misspelled word, it pauses so you can correct the word.
5. When Spelling Sentry is finished checking, it copies any replacements made to the clipboard. You can

paste the corrected text back into your other application's document. You can do this in most 
applications by selecting the Paste item from the Edit menu. Spelling Sentry also displays some 
statistics when it has finished checking the clipboard contents.

Note:

You can cancel a spell-checking session by selecting the Stop Checking button.

See also
How to check a file
How to set preferences
How to respond to spelling errors
Statistics



How to check a single word
1. Select the Word item from the Check menu.
2. Spelling Sentry displays a form which prompts you to enter a word. Type in the word you want to 

check, then select the OK button.
3. Spelling Sentry displays a message which tells you whether the word is correctly spelled or not.

See also
How to check a file
How to check the clipboard



How to respond to spelling errors
When Spelling Sentry detects a misspelled word while checking a file or the clipboard, it pauses to give 
you a chance to respond.
The word which Spelling Sentry considers to be misspelled appears in the Misspelled Word field in the 
main window.
If you have selected the Always Suggest option, Spelling Sentry searches for alternative spellings for the
misspelled word, and displays any suggested words in the list box. If you have not selected Always 
Suggest, you can select the Suggest button. This will cause Spelling Sentry to search for alternative 
words. If the correct spelling doesn't appear in the list, try selecting the Suggest button again. Each time 
you select the Suggest button, Spelling Sentry searches its lexicons a little deeper.
Select one of the following actions:

If the word in the Misspelled Word field is correctly spelled and probably doesn't occur again in the file
or clipboard, select the Ignore button.
If the word is correctly spelled and probably occurs again in the file or clipboard, select the Ignore All 
button. If the word appears again, Spelling Sentry will ignore it.
If the word is correctly spelled and is a word you use often (for example, your family name), select the
Add to Lex button. Spelling Sentry will remember the word in the user lexicon.
If the word is misspelled and the correct spelling appears in the list box, select the correct spelling 
from the list box.

The words surrounding the misspelled word (usually the sentence in which the word appears) are shown
in the area near the top of Spelling Sentry's window.
In some rare cases, Spelling Sentry cannot locate the correct spelling for a misspelled word. If this 
happens, you can edit the word in the Correction field manually. To verify that the word in the Correction 
field is correctly spelled, click on the Recheck button. Spelling Sentry will display a message telling you if
the word is correctly spelled or not.
You can replace the misspelled word with the word in the Correction field by selecting one of the 
following actions:

If the misspelled word doesn't occur again in the document, select the Replace button.
If the word occurs again in the document, select the Replace All button. Spelling Sentry will replace 
this occurrence and each subsequent occurrence of the misspelled word with the word in the 
Correction field.

Note: By selecting the Undo Last button, you can undo the last single replacement made to the 
document.

See also
Buttons and Controls



How to edit a lexicon
You can edit the words in the user lexicon, supplemental lexicon, or exclusion lexicon. However, you 
cannot edit the words in Spelling Sentry's main lexicon.
1. Select the item in the Lexicon menu for the lexicon you wish to edit (User, Supplemental, or 

Exclusion).
2. The lexicon-editor dialog appears. Select one of the following topics for more information:

How to add a word to a lexicon
How to delete a word from a lexicon
How to merge two lexicons
How to clear a lexicon
How to save a lexicon to disk
How to open a different lexicon file

3. To close the lexicon-editor dialog, select the Close button.

See also
Lexicon menu



How to add a word to a lexicon

1. Select the Add button from the lexicon-editor dialog.
2. A dialog appears, prompting you to enter a word. Enter the word you wish to add. The word may 

contain alphabetic characters and apostrophes only; no other symbols or digits are allowed. Note: 
Make sure the word is correctly spelled!

3. Select the OK button. Spelling Sentry adds the word to the lexicon.

See also
How to edit a lexicon



How to delete a word from a lexicon
1. In the list box in the lexicon-editor dialog, select the word you wish to delete.
2. Select the Delete button. Spelling Sentry removes the selected word from the lexicon.

See also
How to edit a lexicon



How to merge two lexicons
You can merge words from one lexicon into another lexicon. You can even merge any set of words into a
lexicon, provided the words are stored in a disk file, one word per line. You can use this feature to merge
the user lexicon (sometimes called the "user dictionary," "personal dictionary," "custom dictionary," etc.) 
into one of Spelling Sentry's lexicons.
1. Select the Merge button in the lexicon-editor dialog.
2. A file-open dialog appears. Locate and select the file containing the words you wish to merge into the 

current lexicon, then select the OK button.
3. The words in the disk file are merged into the current lexicon.

See also
How to edit a lexicon



How to clear a lexicon
1. Select the New button from the lexicon-editor dialog. Spelling Sentry may display a dialog asking if 

you want to save the current lexicon. If you select the Yes button, Spelling Sentry will save the lexicon
to disk.

2. All the words in the current lexicon will be deleted.

See also
How to edit a lexicon



How to save a lexicon to disk
1. Select the Save button in the lexicon-editor dialog.
2. Spelling Sentry copies the word in the lexicon to a disk file.

See also
How to edit a lexicon



How to open a different lexicon file
Spelling Sentry saves the user, supplemental, and exclusion lexicons in disk files. Each lexicon uses the
following default file name:

User lexicon: USERLEX.TXT
Supplemental lexicon: SUPPLEX.TXT
Exclusion lexicon: EXCLLEX.TXT

You can create different lexicon files if you wish. You can also have several sets of lexicon files, each for 
a different purpose; open the lexicon file you want to use via the following procedure:
1. Select the Open button from the lexicon-editor dialog.
2. Spelling Sentry may display a dialog asking if you wish to save the current lexicon. Select the Yes 

button to save the lexicon to a disk file.
3. Spelling Sentry displays a file-open dialog. Locate and select the file containing the lexicon you wish 

to open, then select the OK button.
4. Spelling Sentry displays the new lexicon in the lexicon-editor dialog.

See also
How to edit a lexicon



How to set preferences
You can change the way Spelling Sentry operates to suit your personal preference.
1. Select the Preferences item in the Options menu.
2. The Preferences dialog appears. Select the check boxes in the dialog to enable or disable 

preferences.
Ignore capitalized words: Spelling Sentry will skip any words which start with a capital letter, unless 
the word is the first word in a sentence. This option is useful if your document contains many proper 
names.
Ignore words with numbers/symbols: Spelling Sentry will skip any words which contain embedded 
numbers or other non-alphabetic symbols Examples: K2J, X11, DOS6.
Report mixed-case words: Spelling Sentry will report as misspelled words which contain unusual 
combinations of upper- and lower-case letters, even if the words are otherwise spelled correctly. 
Examples: PrintScreen, hAppy, CodeHead.
Report doubled words: Spelling Sentry will report as misspelled any word which appears twice in a 
row, unless the first word appears at the end of a sentence. Example: the the.
Always suggest: Spelling Sentry will always suggest alternative words when a misspelled word is 
detected. If this option is disabled, you can obtain suggested words by selecting the Suggest button. 
Disabling this option will make Spelling Sentry run faster.
Make backup copy of changed files: Spelling Sentry will make a backup copy of any disk files 
changed using the Replace or Replace All buttons. The backup copy will have the same name as the 
original file, but it will end in .BAK. For example, if you replace words in a file called CHAP1.WRI, 
Spelling Sentry will leave the original contents in a file called CHAP1.BAK.

3. Once you have made your option selections, select the OK button.

See also
Options menu
Suggest button
Replace button
Replace All button



How to exit Spelling Sentry
To exit Spelling Sentry, select the Exit item from the File menu.

See also
File menu



Misspelled Word

Spelling Sentry considers a misspelled word to be
1. Any word appearing in the exclusion lexicon
2. Any word not appearing in the user, supplemental, or main lexicons.



Always Suggest Option
The Always Suggest option determines whether Spelling Sentry automatically attempts to locate 
suggested alternative replacements for a misspelled word. Turning this option off may save time while 
checking.



User Lexicon
The User Lexicon is intended to contain words which are personal to you. Spelling Sentry's main lexicon
contains many words, but it may not contain words you use every day such as your family name, the 
name of the street you live on, etc. You can add these words to the User Lexicon so Spelling Sentry can 
check that they are spelled correctly when you use them in your writing.



Supplemental Lexicon
The Supplemental Lexicon is intended to contain words which are particular to your business, your 
hobbies, etc. For example, if you are a doctor, you might add medical terms to your Supplemental 
lexicon so Spelling Sentry can check that they are spelled correctly when you use them in your writing.



Exclusion Lexicon
The Exclusion Lexicon contains words which you would like Spelling Sentry to treat as though they were
misspelled. If Spelling Sentry detects a word which exists in the Exclusion Lexicon, it will report it as a 
misspelling even if it is correctly spelled (as defined by the user, supplemental, or main lexicons). You 
might add a word to the Exclusion Lexicon for three reasons:

1. You frequently misstype a word which results in an obscure but valid word (e.g., typing "tan" 
instead of "than")

2. You find the usage of some words confusing, and you want Spelling Sentry to draw your attention 
to them so you can double-check that they are used correctly (e.g., "its" and "it's")

3. You want to be informed when you use certain words because they are unacceptable for some 
reason (e.g., sexist terms)



Main Lexicon
Spelling Sentry's main lexicon is a large body of common English-language words. The main lexicon 
contains about 80,000 words.



Lexicon
A lexicon is a collection of words. The word "dictionary" is interchangable with "lexicon."



Non-alphabetic Symbols
Non-alphabetic symbols are characters which cannot form part of a word. Spelling Sentry considers 
words to be collections of alphabetic characters and apostrophes; anything else is a non-alphabetic 
symbol.



File Menu
The File menu contains file-related commands.

See also:
Check item
Exit item



Check item (File menu)
The Check item causes Spelling Sentry to check the spelling of words in an ASCII text file or Windows 
Write file.

See also
File menu
How to check a disk file
How to check the clipboard



Exit item (File menu)
The Exit item causes Spelling Sentry to terminate.



Check menu
The Check menu contains entries which cause Spelling Sentry to check the spelling of files, the 
clipboard, or individual words.

See also
Check File item
Check Clipboard item
Check Word item



Check File (Check menu)
The Check File item causes Spelling Sentry to check the spelling of words in an ASCII text file or 
Windows Write file.

See also
Check menu
How to check a disk file
How to check the clipboard



Check Clipboard (Check Menu)
The Check Clipboard item causes Spelling Sentry to check the spelling of words contained in the 
Windows clipboard.

See also
Check menu
How to check a disk file
How to check the clipboard



Check Word (Check Menu)
The Check Word menu item causes Spelling Sentry to check the spelling of a single word.

See also
Check menu
How to check a single word



Options menu
The Options menu contains a single item, Preferences, which you can use to display a dialog to edit 
Spelling Sentry options.

See also
How to set preferences



Lexicon Menu
The Lexicon menu contains items you can select to edit the user lexicon, supplemental lexicon, or 
exclusion lexicon.

See also
User Lexicon item
Supplemental Lexicon item
Exclusion Lexicon item



Supplemental Lexicon (Lexicon Menu)
The Supplemental Lexicon item displays a dialog you can use to edit the supplemental lexicon.

See also:
Lexicon menu
How to edit a lexicon



User Lexicon (Lexicon Menu)
The User Lexicon item displays a dialog you can use to edit the user lexicon.

See also
Lexicon menu
How to edit a lexicon



Exclusion Lexicon (Lexicon Menu)
The Exclusion Lexicon item displays a dialog you can use to edit the exclusion lexicon.

See also
Lexicon menu
How to edit a lexicon



Help Menu
Use the Help menu commands to get information about Spelling Sentry:
Index: Use this command to display the opening screen of Help. From the opening screen, you can 
jump to step-by-step instructions for using Spelling Sentry and various types of reference information.
About: Use this command to determine the Spelling Sentry version number, the Spelling Sentry DLL 
version number, and copyright information.



Buttons and Controls
Click on the area of interest in the following figure for more information:



Context Area
The Context Area shows the context in which a misspelled word is found. Usually, the context is the 
sentence containing the word. You can use the scroll bars at the right side of the Context Area to bring 
more of the context into view.



Misspelled Word Field
The Misspelled-Word field shows the word which Spelling Sentry considers to be misspelled.



Correction Field
The Correction field contains a replacement for the misspelled word. You can enter a correction word by 
typing it through the keyboard, pasting it from the clipboard (press Ctrl+V), or by selecting one of the 
suggested words in the Suggestions list box.

See also
Suggestion list box



Suggestion List Box
The Suggestions list box contains suggested alternative words which Spelling Sentry recommends as 
replacements for the misspelled word. When you select a word in the list box, it is automatically copied 
to the Correction field.

See also:
Correction field



Words Checked Field
The Words-Checked field displays the total number of words checked in a file or clipboard. The number 
to the right of this field shows what portion of the file or clipboard has been checked, expressed as a 
percentage.



Add to Lex Button
The Add to Lex button adds the word in the Misspelled Word field to the user lexicon. Use this button if 
the word which Spelling Sentry flagged as misspelled is actually correctly spelled, and is a word you use
frequently.

See also
How to edit a lexicon



Recheck Button
The Recheck button causes Spelling Sentry to check the spelling of the word in the Correction field. 
Spelling Sentry displays a message indicating whether the word is correctly spelled or not. Use this 
button if you type in a word to replace the misspelled one, and want to double-check the spelling.

See also
How to respond to spelling errors



Suggest Button
The Suggest button causes Spelling Sentry to search for replacements for the word in the Misspelled 
Word field. Use the Suggest button if you want Spelling Sentry to look up the correct spelling for a 
misspelled word. Any suggested replacements found will be displayed in the Suggestions List Box. 
Pressing the Suggest button again may yield better suggested words. When the Suggestion button is 
disabled (grayed), no further suggestions can be located.

See also
How to respond to spelling errors



Ignore Button
The Ignore button causes Spelling Sentry to skip the current word in the Misspelled Word field.    If the 
word appears again, Spelling Sentry will regard it as misspelled. Use the Ignore button if the word is 
actually correctly spelled, but probably doesn't occur again in the file or clipboard.

See also
Ignore All button
How to respond to spelling errors



Replace Button
The Replace button causes Spelling Sentry to replace the misspelled word with the word in the 
Correction field. Only this occurrence of the word is replaced. Use the Replace button if the misspelled 
word isn't likely to appear again in the current file or clipboard.

See also
Replace All button
How to respond to spelling errors



Ignore All Button
The Ignore All button causes Spelling Sentry to ignore this and all further occurrences of the misspelled 
word in the current file or clipboard. Use the Ignore All button if the word in the Misspelled Word field is 
actually correctly spelled and probably occurs again in the file or clipboard.

See also
Ignore button
Replace All button
Add to lex button
How to respond to spelling errors



Replace All Button
The Replace All button causes Spelling Sentry to replace this and all further occurrences of the 
misspelled word with the word in the Correction field. Use the Replace All button when the misspelled 
word is likely to occur again in the same file or document.

See also
Replace button
Ignore All button
How to respond to spelling errors



Undo Last Button
The Undo Last button causes Spelling Sentry to restore the last single replacement made to a 
misspelled word. The Undo Last button is enabled only if the last replacement can be undone. Note that 
replacements made via the Replace All button cannot be undone.

See Also:
Replace button
Replace All button



Stop Checking Button
The Stop Checking button causes Spelling Sentry to cancel a file check or clipboard check in progress.   
Any replacements made to the file or clipboard are lost.



Statistics
When Spelling Sentry has completed checking a file or the clipboard, it displays some statistics.
Words Checked: The total number of words in the file or clipboard.
Sentences: The approximate number of sentences in the file or clipboard. Spelling Sentry counts 
sentences by recognizing sentence-terminating punctuation (i.e., periods, question marks, and 
exclamation marks).
Flesch-Kincaid Readability Grade: A score indicating the readability of your writing, expressed as the 
approximate number of years of schooling needed to understand it.
Fog Index: Another readability score.




